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How to Get Help
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ciated with your system and/or its networked equipment. Also
realize that, if such an intrusion should occur, it could result in a
variety of lossesto your company, including but not limited to,
human/data privacy, intellectual property, material assets, finan-
cial resources, labor costs, and/or legal costs).

Responsibility for Your Company’s Telecommunications
Security
The final responsibility for securing both this system and its net-
worked equipment rests with you — an Avaya customer’s system
administrator, your telecommunications peers, and your managers.
Base the fulfillment of your responsibility on acquired knowledge
and resources from a variety of sources including but not limited
to:

« Installation documents

¢ System administration documents

e Security documents

« Hardware-/software-based security tools

« Shared information between you and your peers

¢ Telecommunications security experts
To prevent intrusions to your tel ecommunications equipment, you
and your peers should carefully program and configure your:

¢ Avayaprovided telecommunications systems and their

interfaces
« Avayaprovided software applications, aswell astheir
underlying hardware/software platforms and interfaces
« Any other equipment networked to your Avaya products

TCP/IP Facilities

Customers may experience differencesin product performance,
reliability and security depending upon network configurations/
design and topol ogies, even when the product performs as war-
ranted.

To order copiesof thisand other documents
Call: Avaya Publications Center
Voice 1.800.457.1235 or 1.207.866.6701
Fax 1.800.457.1764 or 1.207.626.7269

Write: GlobaWare Solutions

200 Ward Hill Avenue

Haverhill, MA 01835 USA

Attention: Avaya Account Management
Email: totalware@gwsmail.com

For the most current versions of documentation, go to the Avaya
Web site:
http:www.avaya.com/support/



http://www.avaya.com/support
http://www.avaya.com/support/
http:www.avaya.com/support/

Table of Contents

Chapter 1T — Welcome. . . ...........o s
Purpose . . 5
Prerequisites . ... ..ot 5
Intended Audience ......... ... ... 5
Conventions Used in This Book ............................. 5
Additional Resources . ........ ...t 6
Tell Us What You Think! ....... ... ... . .. .. . . .. . .. .. 6
How to Get This Book (and Others) onthe Web ................ 7
How to Order More Copies of ThisBook ...................... 7
Chapter 2 — OVEerVieW . ... .. ...t e e anaaeneenns
What’s New in Release 1.32 ... ... . .. . .. ... .. 9
The Upload and Download Process ...................coo.... 9
Uploading Translations from the Main Server .............. 9
Modifying Translations for the WSPs . ................... 10
Downloading Translations to the WSPs . .. ................ 10
Scheduling Uploads/Downloads . ........................... 11
Limited Administration of WSPs .. ....... . ... ... .. ........ 11
SECUTILY . o vt 12
Installation Checklist ........ ... .. .. .. . . . 12
Getting Help with the Installation .......................... 14
Chapter 3 — Understanding System Requirements . ............ 15
PC RequUIrements . ... .. ...ttt 15
Enabling Avaya Remote Services . ................uiiuunn... 16
Main Server and WSP Requirements . ....................... 16
Chapter 4 — Connecting the Hardware. . ..................... 17
Connecting via CLAN Board . . . ....... ... i 17
Chapter 5 — Preparing Servers and WSPs for ASP Manager. . . . .. 19
OVEIVIEW . oo e 19
Enabling ASG on Your Main Servers ........................ 21
Enabling MultiVantage Software to Work with
ASP Manager .. ... vttt e 22
Creating the Upload/Download Login . ...................... 22
Do you need to create thislogin? ....................... 22
If you need to create thislogin ......................... 23

Avaya™ ATM WAN Survivable Processor Manager Installation and Configuration



Table of Contents

Creating the Administrative Login . ......................... 25
Do you need to create thislogin? ....................... 25
If you need to create thislogin ......................... 25
Chapter 6 — Installing ASP Manager. .. ............ccccuuuuun. 29
Installation Prerequisites . ................inueerrnnnn... 29
Understanding pcAnywhere Security .. ...................... 29
Installing ASP Manager .. ..........c.ouimiineuneennanenn. 30
Shutting Down ASP Manager . . . .. .....uuutiteienenenennn.. 32
Starting ASP Manager .. ... .. ...ttt 32
Starting the ASP Manager Server ....................... 32
Starting the ASP Manager Client . ....................... 33
Uninstalling ASP Manager ..............uuuuineeeinnnnn .. 33
Chapter 7 — Configuring ASP Manager .................c..... 35
Setting the PC's Time .. ... ...ttt 35
Specifying the Main Server ................. .. ..o u.ou.... 36
Specifying WSP Information .............................. 37
Setting Up E-mail Notification ............................. 38
Using ASP Manager . . ... ..v ettt e 38
Chapter 8 — Testing the Installation . . . .. .................... 39
Testing CONNECHONS . . ..o vttt et e et e e e 39
Troubleshooting ........... ... ... . ... ... 40
Index. . ..o e 45
4 Avaya™ ATM WAN Survivable Processor Manager Installation and Configuration



1 Welcome

Purpose

This book explains how to install and configure Avaya™ ATM WAN Spare Processor
Manager, how to test the installation, and how to troubleshoot it.

Prerequisites

Installing ASP Manager requires familiarity with data networking concepts, knowledge of
your company’s data network, and proficiency with Windows.

Intended Audience

We wrote this book for PC Administrators who are responsible for installing this software.

Conventions Used in This Book

In this book, we use the following typographical conventions:

e  We use bold type for emphasis and for any information that you should type; for
example: save translation.

e We use Courier font for any information that the computer screen displays; for
example: | ogi n.

e We use arrows to indicate options that you should select on cascading menus; for
example: “Select File>Open” means choose the “Open” option from the “File” menu.

e  We use the term “main server” to mean DEFINITY Server R.
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Additional Resources

Additional Resources

You may find the following additional resources helpful.

For help using ASP Manager, look in the online help. For more detailed information on ATM
WSPs, see ATM Installation, Upgrades, and Administration Using Avaya MultiVantageD Solutions,
555-233-124.

For help with complex administration tasks, use the Administrator’s Guide for Avaya
MultiVantageD Software, 555-233-506, which explains system features and interactions in
detail.

Tell Us What You Think!

Let us know how this book measured up to your expectations. Your opinions are crucial to
helping us meet your needs! Please complete and return the comment card at the front of
this book. Optionally, send us your comments by mail, fax, or e-mail, as follows:

Mail: Avaya Inc.
ASP Manager Documentation Team
Room 3C-313
307 Middletown Lincroft Rd.
Lincroft, NJ 07738-1526
USA

Fax: ASP Manager Documentation Team
+ 1732 852-2469

E-mail: document@avaya.com
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How to Get This Book (and Others) on the Web

You can view or download the latest version of this book from the Avaya, Inc. web site. You
must have access to the Internet, an Internet browser, and Adobe Acrobat Reader (version
5.0 or later) with Search. Adobe Acrobat Reader is available from http://www.adobe.com.

To view or download the latest version of the Avaya VisAbility Management Suite
documentation:

1. Access http://www.avaya.com/support.
2. Click Product Documentation.
3. Click System and Network Management.

4. Locate the heading “Avaya VisAbility Management Suite,” and click the link
corresponding to the software release.

5. Locate the title of the book, and click the link corresponding to the book.

How to Order More Copies of This Book

To order paper copies of this book, call or write us and request the following publication:

Order: Document Number:555-233-223
Issue: Issue 5
Date: May 2003

Call:  Avaya Publications Center
Voice: 1 800457 1235
Fax: 1 800 457 1764

If you are calling from somewhere that cannot access US 1-800 numbers, then call:
Voice: + 1207 866 6701
Fax: + 1207 626 7269

Write: Globalware Solutions
200 Ward Hill Avenue
Haverhill, MA 01835
USA
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2 Overview

Avaya™ ATM WAN Spare Processor Manager (ASP Manager) is a client-server application
that allows you to upload translations from Avaya MultiVantage™ software on a “main”
server and download them to multiple WAN spare processors (WSPs) simultaneously,
according to a schedule you specify. This chapter explains roughly how the application
works, explains security considerations, and summarizes the installation process.

What's New in Release 1.3?

The ASP Manager client now runs on Windows XP Professional in addition to all previously
supported platforms. Also, ASP Manager now allows you to specify a name of your own
choosing when you set up email notification, and it allows you to manually test your email
notification configuration. Finally, upload and download speeds have improved.

The Upload and Download Process

ASP Manager copies translations from MultiVantage software on the “main” server to its
WSPs as follows.

Uploading Translations from the Main Server

When ASP Manager copies translations from a main server to its WSPs, it first makes a
connection with the main server over an Ethernet LAN or WAN, via the C-LAN board on the
main server. It logs in to the main server using an “administration” login ID and password
that has already been set up on the main server and specified in ASP Manager. It issues the
save translations command, and if the command is successful, ASP Manager logs off and
disconnects. It then reconnects using the “upload/download” login, and issues the upload
translations command. (If the save translations command fails, ASP Manager will proceed
with the second command only if you have specified that ASP Manager should do so.) The
translations from the main server are uploaded to ASP Manager, and then ASP Manager
disconnects. ASP Manager logs the success or failure of the upload in its log, which you can
view from the ASP Manager user interface. If the translations were uploaded successfully,
ASP Manager keeps a copy before downloading the translations to the WSPs.
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The Upload and Download Process

Modifying Translations for the WSPs

ASP Manager does not download an exact copy of the translations to the WSPs. If it did, it
would overwrite critical connectivity information that allows the WSP to communicate with
other systems. Instead, after uploading translations from the main server, ASP Manager
makes some minor adjustments to the translations; for example, changing IP address, port,
and node name information, as appropriate, to work on the given WSP.

Downloading Translations to the WSPs

Once ASP Manager has uploaded translations from the main server, it issues the status atm
wsp command on the main server. If the WAN Processor Role field contains a value of
“pending”, no WSP data is available and ASP Manager logs an error. If the WAN Processor
Role field contains any other value, ASP Manager can then display the name, number, and
link status of each WSP in the network.

ASP Manager then connects and logs in to each WSP, using login IDs and passwords that
have previously been set up on the WSPs and specified in ASP Manager. ASP Manager issues
the status atm wsp command on each WSP. If the WAN Processor Role field contains a
value of “spare” and the State field contains a value of “standby,” then ASP Manager issues
the save translations removable-media command, and then the download
translations command. If the WAN Processor Role and the State fields contain any other
values, then ASP Manager aborts the save translations and the download and logs an error.
After ASP Manager downloads translations successfully, it does one of two things: for
anything prior to DEFINITY ECS Release 10 systems, it issues a reset system 4 disk
command; for DEFINITY ECS Release 10 and later systems, it issues a reset system 3 disk
preserve-license command. These commands reboot the WSP in a forced-standby mode.
This terminates the connection between the WSP and ASP Manager.

Several minutes later, ASP Manager attempts to reconnect to the rebooted WSP. If it fails, it
tries again in another several minutes. If it fails again, it logs an error in its status log. If it
succeeds, ASP Manager modifies the translations. Precisely how depends on whether or not
the main server has the “critical reliability” feature enabled.
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If the main server has critical reliability enabled, ASP Manager issues the status pnc
command to determine whether A-pnc or B-pnc is active. If B-pnc is active, ASP Manager
issues the command reset pnc interchange override and waits for two minutes. A-pnc
must be active before ASP Manager can issue the command busyout pnc-standby, which
occurs next. If that step is successful, ASP Manager issues the command change system
duplication, and sets both SPE dup and PNC dup to ‘n’. If that is successful, ASP Manager
issues the command busy atm pnc 1, and if that is successful ASP Manager issues the
command remove atm pncl. Next, ASP Manager issues the command list config all to
determine the physical location of the ATM interface circuit packs. This returns two locations.
Then, ASP Manager issues the command change system maintenance, changing the value
of the field called WSP to ‘SPARE,” entering the ATM interface circuit pack locations
determined with the list config all command, entering the WSP number, and entering the
takeover time. Next, ASP Manager issues the change system duplication command, and
changes the value of the field called PNC dup back to ‘y’. Finally, ASP Manager issues the
commands save trans active and either reset system 4 disk or reset system 3 disk
preserve-license, depending on the release number of the systems.

For systems without critical reliability, ASP Manager issues the busyout atm pnc 1
command; it issues the remove atm pnc 1 command; and then busyout atm pnc 2 and
remove atm pnc 2 (if applicable). Then, it issues a list configuration all command to
retrieve the ATM interface location. This location is required for the next change system
parameters command. This returns one location. Then, ASP Manager makes the following
changes on the change system-parameters maintenance form of the WSP: it enters
“spare” in the WAN Processor Role field; it enters the previously determined location of the
ATM-EI board in the A-PNC Board Location field; it enters the WSP number (gathered from
the main server) in the WSP Number field; and it enters the number of minutes (gathered
from the ASP Manager user) after which the WSP will take over in the event of a main server
failure in the WSP Takeover Time field. Finally, ASP Manager issues the commands save
trans active and either reset system 4 disk or reset system 3 disk preserve-license,
depending on the release number of the systems.

Scheduling Uploads/Downloads

ASP Manager lets you specify when you want to copy translations. You can copy them
immediately or schedule the copy to occur once, daily, or weekly.

Limited Administration of WSPs

ASP Manager lets you set the number of minutes after which a WSP will take over in the
event of a main server failure. All other WSP administration commands are accessible only
from a System Administration Terminal (SAT) or system administration application, such as
Avaya MultiVantage™ Configuration Manager or Avaya Site Administration.
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Security

Security

ASP Manager has no login and password protection. Unauthorized use of ASP Manager is
prevented only through the login and password required by Windows, and the logins and
passwords required by the MultiVantage software on the main servers and WSPs. Once ASP
Manager has been installed and configured, it stores the login IDs and passwords of the main
server and its WSPs on the ASP Manager server, which means from that point forward, only
your Windows security prevents unauthorized users from gaining access to these devices.
However, all that an unauthorized user could do with ASP Manager is copy translations from
the main server to its WSPs. Using ASP Manager, users cannot manually modity translations
between uploading them from the server and downloading them to the WSP, which means
that using ASP Manager, users have no way to introduce errors or sabotage the WSP
translations.

If you have a service agreement with Avaya, or if you want Avaya support during ASP
Manager’s warranty period, you must install a copy of pcAnywhere on the ASP Manager
computers that you want Avaya to support. For the required version number of
pcAnywhere, see “Understanding System Requirements”” on page 15. If used incorrectly,
pcAnywhere can be a security risk. It is your responsibility to protect your network from
unauthorized use. Before installing pcAnywhere, see the guidelines in “Understanding
pcAnywhere Security” on page 29.

Installation Checklist

The installation will follow a process like the one listed below.

1. Connect ASP Manager computers to the main server(s) and WSPs.

We recommend that PC administrators or telephone technicians perform the
following steps.

a. Connect ASP Manager computers, and the main server and WSPs that it supports,
to a LAN or WAN, following the instructions in "Connecting the Hardware" (page
17).

2. Prepare the main server(s) and WSPs for ASP Manager.
We recommend that an Avaya technician perform the following tasks.
a. Install main PPN, ATM-PNC, and WSPs, if you have not already.

For instructions on installing main PPNs and WSPs, visit
http://made-easy.avaya.com and click the MCC link to view Installation for MCC
Made Easy. For instructions on installing ATM-PNC, refer to ATM Installation,
Upgrades, and Administration Using MultiVantage Solutions. A copy of this book is
available from the VisAbility home page, or on your ASP Manager software CD.
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b. Install, administer, and test C-LAN boards on all main servers and WSPs that ASP
Manager will support, if you have not already.

c. Set up asynchronous links, if you have not already.

d. If you will be using Access Security Gateway (ASG) on a main server or WSP that
ASP Manager supports, and if it is not already enabled, then contact Avaya to have
this feature enabled (page 21).

e. Have Avaya enable the “Syst em Managenent Data Transfer Only?” customer
option for each main server and WSP that ASP Manager supports, if it is not
already enabled (page 21).

f. Create an “Upload/Download” login and “Administration” login for each main
server and WSP that ASP Manager supports, if these do not already exist (page
22).

3. Prepare computers for ASP Manager.

a. Upgrade existing computers (if necessary) to meet the hardware and software
requirements specified on page 15.

b. Ensure TCP/IP connectivity between the ASP Manager server and all ASP Manager
clients.

c. Ensure TCP/IP connectivity between the ASP Manager server, the “main” server,
and all of its WSPs.

Make sure they can ping each other. Troubleshoot problems with the LAN/WAN
administrator.

d. Set the PC’s time (page 35).
4. Give Avaya access to your system.

This step applies if you have a maintenance support agreement with Avaya, or if you
want Avaya to be able to support you during ASP Manager’s warranty period. We
recommend that PC administrators perform the following tasks.

a. Install modems and pcAnywhere on all computers that you want Avaya to be able
to access to support ASP Manager.

b. Provide Avaya’s Technical Service Center (TSC) the phone number or IP address to
access ASP Manager computers.

5. Install ASP Manager.
We recommend that PC administrators perform the following tasks.
a. Install ASP Manager client and server software (page 30).

b. Reboot.
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Getting Help with the Installation

6. Configure ASP Manager.
We recommend that PC administrators perform the following tasks.
a. Specify the “main” server connection information (page 36).
b. Specity the WSP connection information (page 37).
c. Set up e-mail notification (page 38).

7. Test the Installation.
We recommend that PC administrators perform the following tasks.
a. Test connections to devices (page 39).

b. Have ASP Manager copy translations from the “main” server to the associated
WSPs and examine the Status Log for errors.

8. Troubleshoot, if appropriate.

We recommend that PC administrators and network administrators collaborate to
perform the following tasks.

a. Troubleshoot hardware connections.
b. Troubleshoot software connections (page 40).

c. Troubleshoot uploading/downloading.

Getting Help with the Installation

If you are located within the United States and require assistance installing ASP Manager,
contact your local Avaya representative for options and details. Please allow a 4-week lead
time to ensure that your requested due date can be met.

If you are located outside the United States and require assistance installing ASP Manager,
contact your Avaya local representative or dealer. Please allow a 4-week lead time to ensure
that your requested due date can be met.
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Understanding System
Requirements

PC Requirements

Any computer you use to run the ASP Manager client or server software should meet the
following requirements:

Parameter Client Server

Operating System | Windows 2000 or XP | Windows 2000
Professional

Processor Intel Pentium II 250 | Intel Pentium III 450 MHz
MHz

Other Software antivirus software antivirus software

RAM 64 MB 128 MB

Available Disk 10 MB* 100 MB, plus

Space 15 MB for each main switch or WSP*

CD-ROM Drive Yes Yes

Network Type Ethernet Ethernet

* Note: *If client and server software are on the same computer, add these space
requirements together.

In addition, ASP Manager computers must be on the same LAN or WAN as the main
server(s) and WSPs that ASP Manager will support. If you want to use ASP Manager’s E-mail
notification feature, then the ASP Manager server must have access to the SMTP mail server
that would be sending the notification E-mail.

IP addresses on the ASP Manager client and server computers can be static or DHCP. If you
are using DHCP, you must refer to the ASP Manager server by host name.

ASP Manager can run on the same computer with Avaya Site Administration and
pcAnywhere.
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Enabling Avaya Remote Services

Enabling Avaya Remote Services

If you have a maintenance agreement with Avaya for support of ASP Manager, you are
required to install a modem and a copy of Symantec’s pcAnywhere on the computers that
you want Avaya to be able to access. pcAnywhere enables Avaya personnel to remotely
troubleshoot and correct problems on your system.

Before installing pcAnywhere, please read the pcAnywhere security guidelines on page 29,
and visit the following web site for the latest pcAnywhere security information:
http://www.symantec.com/pcanywhere/index.html

Main Server and WSP Requirements

ASP Manager supports Release 9.1 or greater of DEFINITY ECS systems, and systems running
MultiVantage software. In addition, your “main” server and WSPs must meet the following
requirements:

1. A C-LAN board must be installed, asynchronous links must be configured, and the
board and configuration must be tested and fully functioning, both on the main
server(s) and each of the WSPs that ASP Manager will support.

2. The main server(s) and the WSPs that you want to work with ASP Manager must all
be on the same LAN or WAN, and that must be the same LAN or WAN that supports
all of the ASP Manager computers.
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4 Connecting the Hardware

To function properly, Avaya™ ATM WAN Spare Processor Manager must be connected to
your Avaya MultiVantage™ software servers and ATM WSPs via a C-LAN board. Figure 1

illustrates one way to connect your ASP Manager computers to your main servers and WSPs.

Connecting via CLAN Board

MultiVantage Server

259A
al

o dapter T
C-LAN % LAN
i Category 5

© RJ-45 RJ-45 I

- ASP Mgr computer

cydrdta LIJK 103100

Figure 1. Connecting main servers and WSPs via Network

1. Connect the equipment as shown in Figure 1.
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Connecting via CLAN Board
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5 Preparing Servers and WSPs for
ASP Manager

Before you can use Avaya™ ATM WAN Spare Processor Manager (ASP Manager) to copy
translations to WSPs, the following activities must happen. A number of these activities

require you to call Avaya. To avoid calling repeatedly, read all of the sections first, and then
determine what activities you need Avaya to perform.

* Note: We refer to the book, ATM Installation, Upgrades, and Administration Using
MultiVantage Solutions, 555-233-124, Issue 4, several times in this procedure. This
book is available from the VisAbility home page, from your ASP Manager
software CD, or from the Service Centre web site (see “How to Get This Book
(and Others) on the Web” on page 7).

Overview

1. Install the main server and MultiVantage software, if you have not already.

For instructions on installing main PPN, visit http://made-easy.avaya.com and click
the MCC link to view Installation for MCC Made Easy.

2. Install the ATM-PNC, if you have not already.

Refer to “Installing a DEFINITY Server ATM-PNC” on page 3-1 in ATM Installation,
Upgrades, and Administration Using MultiVantage Solutions, 555-233-124, Issue 4.

3. Install the WSPs, if you have not already.

Refer to “Installing a WAN Spare Processor” on page 3-36 in ATM Installation, Upgrades,
and Administration Using MultiVantage Solutions, 555-233-124, Issue 4. In addition:

a. On the WSP, if there are only two carriers installed, make sure that the second
carrier is a ‘C’ carrier. Chances are the PPN has duplicated SPEs, which makes the
01B carrier a processor carrier. WSPs have single processors. Once the WSPs have
a copy of the PPN’s translations loaded and running, SPE dup will be turned off.

Therefore, in order to make use of the second carrier, it should have the ‘C’ p-plug
connected to it on the backplane.

b. If the WSP has 3 carriers, you can either make the second carrier a ‘C’ carrier (as in
Step 3a, above) or you can leave the second carrier as a ‘B’ carrier, and simply not
put any circuit packs in it. Instead, place your C-LAN circuit pack in the ‘C’ carrier.
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Overview

4. Verity that the WSP configuration matches the main PPN configuration.

5.

6.

Refer to Figure 3-11 in ATM Installation, Upgrades, and Administration Using
MultiVantage Solutions., 555-233-124, Issue 4.

Administer the WSPs on the main server.

Refer to “Administration” on page 3-42 in ATM Installation, Upgrades, and
Administration Using MultiVantage Solutions., 555-233-124, Issue 4.

Install the C-LAN circuit pack.

Refer to “Installing and Administering a C-LAN Circuit Pack” on page 3-49 in ATM
Installation, Upgrades, and Administration Using MultiVantage™ Solutions, 555-233-124,
Issue 4. In addition:

a. Make sure that the C-LAN circuit pack that ASP Manager uses to connect to the
PPN is in cabinet 01, preferably in the 01C or 01D carrier.

b. Do not put the C-LAN circuit pack in the B carrier on any of the WSPs.

c. Make sure the node names of the C-LAN circuit packs are the same for all of the
C-LAN circuit packs on both the PPN and all WSPs. Use the change node- nanes
i p command.

d. Do not attempt to enter the node names of the WSPs” C-LAN circuit packs in the
Node Names screen of the PPN. (It is not possible, even if you perform Step c,
above.)

7. Test C-LAN connectivity to the LAN.

Refer to “Testing the external connection to the LAN” on page 3-54 in ATM
Installation, Upgrades, and Administration Using MultiVantage Solutions, 555-233-124,
Issue 4. In addition:

a. Make sure you have C-LAN SAT access to the PPN and each WSP.

b. The PC that will be running the ASP Manager server should also be able to access
each of these C-LAN circuit packs.

c. If necessary, for troubleshooting purposes, you can install a copy of Avaya Site
Administration on the PC that will be running the ASP Manager server.

8. If you want to use Access Security Gateway (ASG), have Avaya enable it on your

servers and/or WSPs. (page 21)

9. Have Avaya turn on the Syst em Managenent Data Transfer Only? customer option

on each server and WSP that you plan to use with ASP Manager. (page 22)

10. On each main server and WSP, create a login that ASP Manager can use to upload or

download translations, or use existing logins that have these permissions. If you create
new logins for this purpose, have Avaya enable them. (page 22)
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11. On each main server and WSP, create a login that ASP Manager can use for all other
administration, or use existing logins that have this permission. If you create new
logins for this purpose, have Avaya enable them. (page 25)

After you complete the above preparations, you can install and configure ASP Manager, as
described in the next chapter. (page 35)

Enabling ASG on Your Main Servers

ASG is an optional security feature that prevents unauthorized persons from accessing the
MultiVantage software on your servers and WSPs. To determine if the ASG feature is enabled
on your server or WSP, complete the following steps:

1. Log in to the MultiVantage software on your server or WSP.
2. Type display system-parameters customer-options and press enter.

If the Access Security Gateway field has a value of y, then your server has the ASG
feature.

If your system does not have the ASG feature enabled, and you want it, you can order it by
completing the following steps:

1. Call Avaya (see numbers below).
2. Give Avaya your Installation Location (IL) number.

3. Request that Avaya turn on the ASG customer option.

If you are calling from the United States... Dial...

CT, DC, DE, FL, GA, MA, ME, NC, NH, NJ, NY, 1-800-632-0900
PA, RI, SC, VA, VT, WV

AL, AR, IA, IL, IN, KS, KY, LA, MI, MN, MO, 1-800-572-0036
MS, ND, NE, OH, SD, TN, WI

OK, TX 1-800-527-6889
AK, AZ, CA, CO, H]I, ID, MT, NM, NV, OR, UT, 1-800-829-8888
WA, WY

If you are calling from outside the United States, contact your Avaya representative or
dealer.
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Enabling MultiVantage Software to Work with
ASP Manager

The ASP Manager software will not work with your PPN/WSP installation unless the DNA
option (in R9) or the System Management Data Transfer option (in R10 and later) is set to
“y” on the System-Parameters Customer-Options form. Only Avaya can set this option.

To determine whether your system has the Syst em Managenent Data Transfer Only?
customer option turned on, complete the following steps:

1. Log in to the MultiVantage software on the “main” server or WSP.
2. Type display system-parameters customer-options and press enter.

If the Syst em Managenent Data Transfer Only? field has a value of y, then the
option is enabled, and your server will work with ASP Manager.

If this option is not enabled, you can enable it as follows:

1. Call Avaya (see numbers above).
2. Give Avaya your Installation Location (IL) number.

3. Request that Avaya turn on the Syst em Managenent Data Transfer Only?
customer option.

Creating the Upload/Download Login

On each “main” server and WSP that you will be using with ASP Manager, there must be a
login that ASP Manager can use to upload translations (from the “main” server to the ASP
Manager server), or download translations (from the ASP Manager server to the WSPs).
MultiVantage software allows only one login with this permission.

* Note: The WSP and PPN will be using the same two logins for Administration and
uploading/downloading translations.

Do you need to create this login?

Any login that has permissions to issue the upload, download translations, and logoff
commands will work. If an appropriate login already exists on the main server and WSPs,
then go to “Creating the Administrative Login’’ on page 25.
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If you need to create this login

The following procedure creates a login that, for security purposes, can only issue the
upload, download translations, and logoff commands. To create the login, complete the
following steps:

* Note: To perform this task, you must have permissions in the MultiVantage software to
add and change logins.

1. Log in to the MultiVantage software.
2. At the command line, enter add login <name>
Where <name> is the word you want to use as the login.
3. Enter your password.
4. Verify that the Logi n Type: field is set to customer.
5. Verify that the Servi ce Level : field is set to non-super-usetr.

6. In the Logi n’ s password: field, enter the password that you want to associate with
the login.

7. In the Reenter Login's password: field, enter the password again.

8. If you want this login to use ASG, then in the Access Security Gat eway? field, enter
a 'y and complete the fields on page 2 of the form (described in the following table).

If you do not see this field, your server does not have the ASG feature enabled. To
enable it, see “Enabling ASG on Your Main Servers”” on page 21.

Field Description

Blocked Enter y to temporarily disable the login ID from accessing
this system through ASG.

System To use ASG, either you or the MultiVantage software on
Generated this system must generate a Secret Key, which you must
Secret Key? enter on this server and in ASP Manager when you are

configuring it. Enter a y to have the MultiVantage software
on this server generate the Secret Key.
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Field

Description

Secret Key

If you want to create your own Secret Key, enter it in
this field. Be sure to note the Secret Key; you will
need it to configure ASP Manager and/or any
response generation devices.

The Secret Key must conform to the following
requirements:

It must be 20 digits long.
Each digit must be between 0 (zero) and 7, inclusive.
The last number must be 0 (zero).

The next-to-last number must be 0 (zero), 2, 4, or 6.

Expiration Date

To disable this login after a certain date, enter the date in
this field. If you enter a value in the Number of Sessions
field, then the login will be disabled based on whichever
criteria is satisfied first.

Number of
Sessions

Enter the number of times this login ID can be used to
access this system (between 1 and 999). If you enter a
value in the Expiration Date field, then the login will be
disabled based on whichever criteria is satisfied first.

Restrict Days of
Week

Enter y to restrict this login from accessing this system on
the specified day of the week.

Restrict From
Time and
Restrict To Time

Enter the time interval during which this login ID is
blocked from accessing this system.

9. Press enter to submit the form.

10. Call Avaya. (page 21)

11. Give Avaya your Installation Location (IL) number.

12. Give Avaya the login name you just added, and request that they enable the Syst em
Managenent Data Transfer Only? field on the first page of the Change Permissions
form for your MultiVantage software.

* Note: Only Avaya can set the Syst em Managenent Data Transfer Only? field to
y. ASP Manager will not work with your server until this is enabled.
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Creating the Administrative Login

ASP Manager needs a login that it can use to issue all of the commands described in
"Downloading Translations to the WSPs" and “Limited Administration of WSPs”” on page 11.
The ASP Manager administrative login is what ASP Manager uses to make changes to the
translations in your MultiVantage software. ASP Manager cannot make changes to the
translations if you do not create this login.

Do you need to create this login?

Any login will work that has permissions to issue the commands status atm wsp, reset
system 4 disk (for DEFINITY ECS Release 9 systems), reset system 3 disk
preserve-license (for DEFINITY ECS Release 10 and higher systems), list config all,
busyout atm pnc 1, remove atm pnc 1, save translations, and logoff. If an appropriate
login already exists on the main server and WSPs, then skip the remainder of this section.

If you need to create this login

To create the administrative login, you must have permissions in the MultiVantage software
to add and change logins.

1. Access the MultiVantage System Administration screens.
2. At the command line, enter add login <name>

Where <name> is the word you want to use as the login. If your location uses DNA, do
not reuse DNA logins for this purpose.

3. Enter your password.
4. Verify that the Logi n Type: field is set to customer.
5. Verify that the Servi ce Level : field is set to super-user.

6. In the Logi n’ s password: field, enter the password that you want to associate with
the administrative login.

7. In the Reenter Login's password: field, enter the password again.

8. If you want this login to use ASG, then in the Access Security Gateway? field, enter
a 'y and complete the fields on page 2 of the form.
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If you do not see this field, your server does not have the ASG feature enabled. To
enable it, see “Enabling ASG on Your Main Servers” on page 21.

Field Description

Blocked Enter y to temporarily disable the login ID from accessing
the server through ASG.

System To use ASG, either you or the MultiVantage software on

Generated | this server must generate a Secret Key, which you must

Secret Key?

enter on the server and in ASP Manager when you are
configuring it. Enter a y to have the MultiVantage software
on this server generate the Secret Key.

Secret Key

If you want to create your own Secret Key, enter it in
this field. Be sure to note the Secret Key; you will
need it to configure ASP Manager and/or any
response generation devices.

The Secret Key must conform to the following
requirements:

It must be 20 digits long.
Each digit must be between 0 (zero) and 7, inclusive.
The last number must be 0 (zero).

The next-to-last number must be 0 (zero), 2, 4, or 6.

Expiration | To disable this login after a certain date, enter the date in

Date this field. If you enter a value in the Number of Sessions
field, then the login will be disabled based on whichever
criteria is satisfied first.

Number of | Enter the number of times this login ID can be used to

Sessions access the Multivantage software on this server or WSP
(between 1 and 999). If you enter a value in the Expiration
Date field, then the login will be disabled based on
whichever criteria is satisfied first.

Restrict Enter y to restrict this login from accessing the

Days of MultiVantage software on this server or WSP on the

Week specified day of the week.

Restrict Enter the time interval during which this login ID is blocked

From Time | from accessing the MultiVantage software on this server or

and WSP.

Restrict To
Time
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9. Press enter to submit the form.

10. At the command line, enter change permissions <name>.

11.

Where <name> is the word you used as the login in Step 2. The system displays the
Command Permission Categories form.

Set the fields to y to enable ASP Manager to perform the listed activity.

Use the table below to decide which of the fields to set to y.

The fields listed in the following table are for a basic configuration. Your MultiVantage
software may display more than the following fields. For help setting those fields, refer
to the Administrator’s Guide for Avaya MultiVantageD Software, 555-233-502.

If this field is | Then...

set to Y...

Display Admin Setting this field to y allows ASP Manager to issue status

and Maint atm wsp and display circuit pack commands. The login

Data? you use for ASP Manager administration must have
this field set to y for ASP Manager to work.

System Since this field applies only to vs/si systems, and C-LAN

Measurements? | boards are not available for vs/si systems, this field is
irrelevant for ASP Manager purposes.

System Mgmt Only Avaya can set this field. You should have them

Data Transfer
Only?

set it to y only for your ASP Manager
Upload/Download login.

Administer ASP Manager can issue add, change, duplicate, or remove
Stations? commands for stations, data modules, and associated
features, such as abbreviated dialing, vectors, and routing
tables. You do not need to set this field to y for ASP
Manager to work.
Administer ASP Manager can issue commands to administer AAR/ARS,
Trunks? trunk groups, remote access, and route patterns. You do not
need to set this field to y for ASP Manager to work.
Administer Setting this field to y allows ASP Manager to issue remove
Features? atm pnc and save translations commands. The login
you use for ASP Manager administration must have
this field set to y for ASP Manager to work.
Administer ASP Manager can issue commands to administer logins and
Permissions? command permissions. You do not need to set this field to y

for ASP Manager to work.
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12.

13.

14.

15.

If this field is Then...

set to Y...

Restricted You can specify any objects that you want ASP Manager not

Objects? to be able to access, like stations, trunks, or hunt groups.
You do not need to set this field to y for ASP Manager to
work.

Maintain Setting this field to y allows ASP Manager to issue reset

System system 3 preserve-license and busyout atm pnc
commands. The login you use for ASP Manager
administration must have this field set to y for ASP
Manager to work.

Press enter.

Call Avaya. (page 21)
Give Avaya your Installation Location (IL) number.

Give Avaya the login name you just added, and request that they enable the
Mai nt ai n Syst em field on the Change Permissions form for the MultiVantage
software on this system.

* Note: Only Avaya can set the Maintain System field to y. ASP Manager will not work

with your server until this is enabled.
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6 Installing ASP Manager

Installation Prerequisites

Before you install Avaya™ ATM WAN Spare Processor Manager (ASP Manager), be sure that
the computers you plan to install it on meet the hardware requirements listed in
“Understanding System Requirements’” on page 15.

ASP Manager requires a functioning LAN or loop-back host to operate. The instructions in
this section assume that your LAN is fully operational and that all ASP Manager computers
can ping each other. In addition, to install ASP Manager, you must have a Windows login
with Administrator privileges.

If your company has a support agreement with Avaya, then you need to install a modem and
a copy of Symantec’s pcAnywhere on all computers that will host ASP Manager software.
pcAnywhere enables Avaya service personnel to remotely troubleshoot and correct problems
on your system. For the required version number of pcAnywhere, see “Understanding
System Requirements’”” on page 15. Once pcAnywhere is installed, contact Avaya’s Technical
Service Center (TSC) (from the US: 1 800 242 2121; from outside the US, contact your Avaya
representative or dealer.) Then give them the phone numbers or IP addresses they should use
to access your ASP Manager computers.

Finally, if you want to use ASP Manager’s E-mail notification feature, then the ASP Manager
server computer must have access to the SMTP mail server that would be sending the E-mail.

Understanding pcAnywhere Security

Before you install a copy of Symantec’s pcAnywhere on any of your computers, read this
section.

You are responsible for the security of your data network and for preventing unauthorized
individuals from accessing it. Therefore, exercise caution when using pcAnywhere. Having it
installed does not pose a security risk; it must be up and running, and be configured to
receive calls, before a remote user can enter the system. In addition, pcAnywhere offers a
number of security features.

Avaya™ ATM WAN Survivable Processor Manager Installation and Configuration 29



Installing ASP Manager

Follow these guidelines to protect PCs with pcAnywhere installed:

6.

. Unplug the modem from the phone jack when pcAnywhere is not in use.
. Only run pcAnywhere when necessary.

. Do NOT publish the phone number for the modem that people use to access the

computer.

Change your password after Avaya personnel leave your site and after Avaya
personnel terminate a remote service session.

. Configure the following pcAnywhere security options:

— Require login names for callers.

— Make passwords case sensitive.

— Log all failed connection attempts.

— Set a maximum number of login attempts per call.
— Allow time to enter the complete login.

— Disconnect if inactive.

Configure pcAnywhere to log remote-call and online sessions.

For more information on pcAnywhere, including acquisition and security, visit the following
web site: http://www.symantec.com/pcanywhere/index.html

Installing ASP Manager

To install ASP Manager, you must use a Windows login that has Administrator privileges.
Then, complete the following steps:

. Shut down all applications running on the computer.

. Insert the Avaya VisAbility Management Suite: Network Management Windows

Server CD into the CD drive.

Wait a moment for the CD browser window to appear automatically.

. Click Install Network Management Products.

The installation program extracts the necessary files.

. At the Welcome window, click Next.

. Specify the folder where you want to install the management suite and click Next.
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6. Click the plus sign icon next to ATM WAN Survivable Processor Manager.
The installation program displays the ASP Manager client and server options.

7. Put a check mark by the ASP Manager components you want to install and click Next.

— Client: This can be installed on one or more computers. It is installed on the server
computer automatically when you install the server software.

— Server: This must be installed on a single computer only.
If you plan to install both client and server, click server. This installs both.
8. Verity the information in the “Check Setup Information” screen and click Next.

Click Back to correct any information, and click Next when you are ready to install
the selected applications. The installation program copies the necessary files to your
hard drive.

9. Read the license agreement and if you accept the terms and conditions, click Yes.
10. Specify the computer on which to install the ASP Manager server software.

You can type the computer name or the fully-qualified domain name (FQDN). The
FQDN is the host name followed by the TP domain name. For example:

dnapcl. depart nent. conpany. com

If you do not know the IP address, you can find it as follows: choose
Start>Settings>Control Panel, double-click Network, click the Protocols tab,
select TCP/IP, click the Properties button, and then click the IP address tab.

* Note: Note the information you enter here; you will need it when you install the client.

11. Specity the number of the port through which the ASP Manager server software will
communicate with the ASP Manager clients and other devices, and click Next.

ASP Manager installs the appropriate software.

12. If you selected Client in Step 7, enter the computer name or FQDN, and the port
number, of the ASP Manager server computer.

You recorded this information when you installed the ASP Manager server software.
13. Restart the computer by selecting “Yes, I want to restart my computer now.”

When the computer restarts, the ASP Manager server software will start
automatically. When the client is first started, it displays the first screen that must be
completed to configure ASP Manager. See “Specifying the Main Server” on page 36.

14. Click OK.

You can now install the ASP Manager client on other computers in your network,
using the same process.
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Shutting Down ASP Manager

Before you uninstall ASP Manager, you must shut down ASP Manager. To do so, you must
have access to the ASP Manager server PC. To shut down ASP Manager, complete the
following steps:

1. Exit the client if it is open by choosing File>Exit.
2. Open an MS-DOS window.

Most likely, you can access this from the Windows Start menu, by choosing
Start>Programs, MS-DOS Command Prompt.

3. At the prompt, type net stop “ASPM Server Service”
4. Wait a minute for the ASP Manager server to shut down.

The MS-DOS window will display a message that the services are stopping.

ASP Manager will not notify users when it has shut down, but users will receive an error to
this effect if they attempt to perform an action that requires the ASP Manager server. The
ASP Manager server software will automatically start again after you reboot the ASP
Manager server.

Starting ASP Manager

Starting the ASP Manager Server

Once ASP Manager server software has been installed, the ASP Manager server software
starts automatically each time you restart the computer it is installed on, and it runs
continuously unless you stop it manually. If you have stopped it manually and you want to
restart it without restarting your computer, complete the following steps:

1. Open an MS-DOS window.

Most likely, you can access this from the Windows Start menu, by choosing
Start>Programs, MS-DOS Command Prompt.

2. At the prompt, type net start “ASPM Server Service”
3. Wait a minute for the ASP Manager server to start.

The MS-DOS window will display a message that the services were started
successfully.
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To start the client, choose Start>Programs>Avaya>ATM WAN Survivable Processor
Manager. If you installed ASP Manager under a different Program Group name, select that
instead.

Uninstalling ASP Manager

To remove ASP Manager from a computer, you must have Windows Administrator
privileges.

-

. If the ASP Manager client is running on this computer, close it.
2. From the Windows Start menu, select Settings>Control Panel.
3. Double-click Add/Remove Programs.

4. On the Install/Uninstall tab, highlight ASP Manager and click the Add/Remove
button.

5. Confirm that you want to remove the selected application.

If the selected application uses software components that are also used by another
application, the system displays the Remove Shared File? dialog box. If you know that
the shared file is not being used by any other application, you can delete it by clicking
Yes or Yes to All.

6. Click OK.
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7 Configuring ASP Manager

To configure Avaya™ ATM WAN Spare Processor Manager, you will perform the following
main steps. The rest of this chapter explain these steps in detail.

1. Set the PC’s time.
2. Start ASP Manager. (page 33)
3. Specify the “main” server in the WSP network.

4. Provide connection and login information about each WSP.

5. (Optional) Specify E-mail notification information.

Setting the PC's Time

After ASP Manager is installed, when people use it to schedule downloads to occur from a
“main” server to its WSPs, ASP Manager will execute the download according to the date and
time that the user specifies. However, this date and time is the date and time at the PC where
the ASP Manager server software is installed. For this reason, it is highly advantageous for
the ASP Manager server PC to have the correct date and time set in the operating system.

To do so, complete the following steps:

1. Choose Start>Settings>Control Panel on your Windows PC.

2. In the Control Panel, double-click Date/Time.

3. Specify the date, time, and time zone using the dialog box.

4. Specify whether to automatically adjust for daylight savings time.

5. Click OK.
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Specifying the Main Server

The first time you start ASP Manager, it will ask you to specify the “main” server. To do so,
complete the following steps:

1. Enter the server name.
2. Enter the server’s IP Address.

To determine the server’s IP address, you can ask your LAN/WAN administrator, or
you can gather this information from the server itself, as follows:

a. Login to the MultiVantage software on that server using your favorite system
administration tool.

b. Type display ip-interface and press Enter.
c. Look for the C-LAN board and note the value in the Node Nane field.
d. Then type list node-name and press Enter.
e. Look for the Node Name you noted from the previous screen.
Next to it will be the IP Address for that C-LAN board.

3. Enter the number of the IP Network port on this server’s C-LAN board that ASP
Manager should use to communicate with this server.

This is a IP Network port number (for example, 5000), not a “switch” port address. To
determine the IP Network port, you can ask your LAN/WAN administrator, or you can
gather this information from the MultiVantage software itself, as follows:

a. Log in to the MultiVantage software on this server using your favorite system
administration tool.

b. Type display ip-interfaces and press Enter.
c. Look for the C-LAN board and note the value in the Node Nane field.
d. Then type display ip-services and press Enter.

e. In the Local Node field, look for the Node Name you noted from the previous
screen.

Next to it, in the Local Port field, will be the IP Network port for that C-LAN
board.
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Check or clear the “Continue if save translation fails?” check box.

Before copying translations, ASP Manager issues the save translations command on
the main server. If you check this box, ASP Manager will copy the translations even if
the save translations command fails on the “main” server. If you leave this box
empty, ASP Manager will abort the copy if the save translations command fails.

. In the Upload/Download area, and in the Administration area, specify the login IDs

and passwords of the Upload/Download and Administration logins that you created
(on page 22 and page 25) for the main server.

Check or clear the Use ASG check box.

ASG is an optional security feature in your MultiVantage software. To determine if
ASG is enabled on the main server, see page 21. If you set up the logins on your main
server to use ASG, check this box. Otherwise, leave it empty.

Click Test Connectivity.

Clicking this button tests the connection between the ASP Manager server and the
main server, for both the Upload/Download login and the Administration login. If you
encounter any error messages, see “Troubleshooting’” on page 40. If there are no
errors with connectivity, ASP Manager will display the name, number, and link status
of each WSP in the network, in the “Administration” tab of the main ASP Manager
window. ASP Manager got this information from the main server (assuming that
someone has already entered this information in the main server as part of Step 5 on
page 20).

Click OK.

This saves the information that you entered in this dialog box.

Specifying WSP Information

To finish configuring ASP Manager, you must supply login and password information about
each WSP, as follows:

1.

2.

3.

Double-click a WSP from the list on the “Administration” tab.

ASP Manager displays the WSP Properties dialog box. The name of the WSP is
displayed.

Enter the IP address, port, login IDs, passwords, and ASG information for this WSP, in
the same way you did for the main server.

Specify the WSP Take Over Time.

This is the amount of time you want this WSP to wait in the event of a failure on the
“main” server, before the WSP comes up as the main processor.
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4. Click Test Connectivity.

This tests the connection between the ASP Manager server and the selected WSP, for
both the Upload/Download login and the Administration login. If you encounter any
error messages, see “Troubleshooting’”” on page 40.

5. Click OK.
Setting Up E-mail Notification

Release 1.1 introduced an E-mail notification feature. To set up this feature, complete the
following steps:

1. Choose Tools>Email Notification Configuration.

2. Specify the IP address of the (SMTP) E-mail server that ASP Manager can send
messages to.

3. Specify whether or not this E-mail server requires authentication, and if it does, enter
the login name and password that ASP Manager should use to send messages.

4. Specify under which conditions ASP Manager should send messages.
5. Specify the E-mail address where ASP Manager should send messages.
To do so, click Add, enter the E-mail address, and click OK. Repeat to add more.

6. Specify the name that you want to appear in the “From” line when ASP Manager
sends E-mail.

7. To test the notification feature, click Test.

ASP Manager sends a test message. If the values that you specified in Step 5 are valid,
then the email addresses that you specified will receive the test message.

8. To close the dialog box and save your settings, click OK.

Using ASP Manager

Refer to ASP Manager’s embedded online help for instructions on how to use the product.
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8 Testing the Installation

To test that you have correctly installed and configured all the components of Avaya™ ATM
WAN Spare Processor Manager, complete the following sections.

Testing Connections

To test ASP Manager’s connections to supported devices, complete the following steps:

1. Start ASP Manager (page 32).
2. Select a server on ASP Manager’s main screen.

3. Choose Tools>Validate.

ASP Manager attempts to connect to the main server, and if it is able to log in, it issues
the status atm wsp command. If the WAN Processor Role field contains any value

other than “pending,” then ASP Manager can display the name, number, and link
status of each WSP in the network.
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Troubleshooting

In the table below, find the symptoms in the left column and follow the instructions in the
right.

Message Possible Causes and Solutions

Attempt to remove <1> | After ASP Manager uploads translations from a
non-existing or main server, it makes a copy for each WSP and
un-writable file then, before it downloads the copy to each WSP, it
<translations file name>. modifies the translations slightly so they will work

on the WSP. This message can occur when ASP
Manager attempts to rename the uploaded
translations, if:

e there was an error in uploading the
translations and, in fact, no upload file really
exists on the ASP Manager server.

e there was an error in the file system that
either a) prevented the upload file from
being written to the ASP Manager server
hard drive, or b) prevented the upload file
from being copied and renamed to the WSP
file name.

e you or someone else changed your
permissions after the ASP Manager server
software was installed and configured.

e whoever set up the directory on the ASP
Manager server where the translations are
uploaded didn’t share the directory with you.

Cannot replace file <new See <1>.
translation file name>

Error reading schedule <2> | You should never receive this message. This error
type <type> starting would appear if ASP Manager is running a job
schedule now that has a scheduling option that is no longer

supported by ASP Manager. For example, if
today’s release supports "Run Now," "Run Once,"
"Run Daily," and "Run Weekly," and a subsequent
release supports only 3 options, then you might
see this message. In that case, you can simply click
the Schedule tab and either alter the schedule or
leave it as is and click Submit. By resubmitting the
job, you will clear the error.
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Message

Possible Causes and Solutions

Failed opening
connection to <server>
with <connection state>.

<3>

ASP Manager may encounter problems
connecting to a server or WSP for any of the
following reasons:-

e the IP address, Network Port Number,
default Gateway, or Subnet Mask in ASP
Manager no longer matches what has been
administered in the server or WSP, or on the
LAN/WAN.

e the login ID and password (and possibly ASG
Secret Key) in ASP Manager no longer
matches what has been administered in the
main server or WSP.-

¢ a physical connection has been severed.
¢ the main server or WSP is down.

e the part of the ASP Manager software that
establishes a connection with a main server
or WSP is experiencing problems.

Failed to create
connection object for
<system> <exception
description>.

<4>

This message can occur if ASP Manager
experiences difficulty building a connection file it
uses to make a connection with the named
device. Contact Technical Support, tell them what
you were doing when the error occurred, and give
them the exception description.

Avaya™ ATM WAN Survivable Processor Manager Installation and Configuration

41



Troubleshooting

Message Possible Causes and Solutions

Failed to retrieve ATM <5> | All of these are errors indicate that ASP Manager

PNC board location from was unable to issue a command on the listed

<WSP> <exception server or WSP. Information in the exception

description>. description may give a clue. Possible reasons

Failed to run atmwsp include:

command on <system> e Someone upgraded the MultiVantage

<exception description>. software but didn’t upgrade ASP Manager, or

Failed to run busyout vice versa (post Release 9)

atm pnc command on e There are problems with physical

<WSP> <exception connectivity.

description>. ¢ Someone entered the wrong connection

Failed to run remove information in ASP Manager or on the server

atm pnc command on or WSP (IP Address, Port, Subnet Mask,

<WSP> <exception Gateway, login ID, password, or ASG Secret

description>. Key).

Failed to run reset e Someone changed the connection

system 3 command on information in ASP Manager but not on the

<server> <exception server or WSP, or vice versa.

description>. * There are problems with the permissions

Failed to run save assigned to the ASP Manager login ID(s) that

translation command on you created on the given server or WSP.

<server> <exception You can either troubleshoot the problem yourself

description> using the information provided in the exception

Failed to set system description, or contact Technical Support and give

parameters for <WSP> the exception description to them.

<exception description>

File <translations file See <1>.

name> does not exist or

is un-writable.See <1>

No network <network <6> | ASP Manager creates the network connection file

file path> or modem when you install ASP Manager. Users cannot

<file path + system> configure or modity this file. You should never

connection file(s) exist. receive this message. If you do, the recommended
process is to reinstall the ASP Manager server
software. If that doesn’t work, call Technical
Support and give them the exception description.

The connection <7> | ASP Manager creates the connection definition

definition file <definition file when you install ASP Manager. Users cannot

file> does not exist. configure or modify this file. You should never
receive this message. If you do, the recommended
process is to reinstall the ASP Manager server
software. If that doesn’t work, call Technical
Support.

42

Avaya™ ATM WAN Survivable Processor Manager Installation and Configuration



Message Possible Causes and Solutions

The WSP returned an <8> | This message is purely informational. ASP

unknown Link Status Manager can upload and download translations

<state>. regardless of what the value in the Link Status
field.

Schedule for <main <9> | This message appears when you click the Submit

server> submitted. button on the Schedule tab of ASP Manager’s
main screen. It simply confirms that ASP Manager
has received the change you specified. It does
NOT mean that the job is starting. Rather, the job
will start when you specified for it to start.

Scheduled task failed <10> | All of these errors indicate that ASP Manager was

while: uploading unable to copy translations from the main server

translations. to the ASP Manager server. The only difference

Scheduled task failed between them is when in the uplqad process the

while: verifying WSP list error was detected. Contact Technical Support.

— this message indicates

a fatal condition which

occurred during the

upload translations step.

Scheduled task failed

while: uploading

translations: Save

translations failed for

<main server>. <main

server> set to stop task if

translations save failed.

Scheduled task pending. | <11> | This message appears if you change a schedule, or

Start time is: <date> - when a schedule completes and it is set to run
periodically.

Scheduled task started. <12> | This message appears immediately before ASP

Manager begins copying translations from the
main server to the ASP Manager server. This
message will stay in the history log until the
history log fills and begins to overwrite the first
entries.
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Message

Possible Causes and Solutions

Translations download <13> | This indicates that ASP Manager was unable to

processing for <WSP> copy translations from the ASP Manager server to

has failed. <exception the given WSP. Information in the exception

description> description may give a clue. Possible reasons for
the failure include:-

¢ Problems with physical connectivity

¢ Incorrect or changed connectivity
information (IP Address, Port, Subnet Mask,
Gateway, login ID, password, or ASG Secret
Key)

e Problems with the permissions assigned to
the ASP Manager login ID(s) on the given
server or WSP.

You can either troubleshoot the problem yourself
using the information provided in the exception
description, or call Technical Support.

Translations upload See <10>.

processing for <main

server> has failed.

<exception description>

Upload of translation See <10>.

from <main server> has

failed.

Updated schedule not <14> | This error means that ASP Manager is already in

started due to currently the process of copying translations from a main

active schedule. server to WSPs. Reschedule the job in question to
start after the current job is complete.

Updated WSP list from <15> | Each time you start the ASP Manager client, each

<server> received.

time you choose Tools>Validate, and each time
ASP Manager starts to upload translations, ASP
Manager automatically contacts the main server
and verifies that ASP Manager’s list of WSPs is still
accurate. When the MultiVantage software
returns the updated list of WSPs, ASP Manager
displays this informational message.
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